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Workflow IR 23 - Migrating Survey from InRoads Select Series 2 to OpenRoads Select Series 4

Overview

This document guides you through the process of migrating survey data for projects which were
started in InRoads V8i Select Series 2 into OpenRoads (InRoads V8i Select Series 4). These
SS2 surveys may have been completed and shelved (Case 1 below) or may still be in progress
(Case 2 below).

Survey Project Status Case 1

Case 1: The survey is finished including delivery of a DTM and DGN files to design.

Option 1: Follow the workflow here exactly which provides all the survey deliverables
in OpenRoads format and these deliverables will match the deliverables as though the
survey was produced completely in SS4.

The workflow for migrating the data in Case 1 Option 1 follows these steps:

1. Process the SS2 survey data stored in FWD formatted files thru
OpenRoads Survey, including, adjusting the processed survey data to
correct for changes in linking codes as described in Section I. Import FWD
Survey Data

2. Import SS2 DTM files into OpenRoads terrain models to address terrain
inadequacies as described in Section Il. Import DTMs to Terrain Models

Option 2: Do nothing. The project team decides to continue with SS2 to complete

their design in order to meet the project schedule and critical dates (such as the AD
date). The workflow for migrating the data in Case 1 Option 2 is to do nothing.

Survey Project Status Case 2

Case 2: The survey is only partially complete with some field data processed but other field data
unprocessed. Field data is still being collected with old TMOSS codes.

The workflow for migrating the data in Case 2 follows these steps:

1. Reprocess the current state of the FWD file using OpenRoads Survey as
described in Section I. Import FWD Survey Data

2. Process the remaining field data (SDR, TXT, CSV, etc.) using OpenRoads
Survey (use the same DGN as the FWD) as described in Section L This
processing will not be different than the OpenRoads Survey training class other
than the use of substitution strings shown on page 10.

3. Disregard Section II— develop the terrain model as part of the survey DGN, as
trained in the OpenRoads Survey class.
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Workflow IR 23 - Migrating Survey from InRoads Select Series 2 to OpenRoads Select Series 4

Statement of Need:

A variety of projects have been started in InRoads V8i Select Series 2 and these projects
currently exist in a variety of stages of development. Some surveys are completed and prepared
for delivery to design as per deliverables requirements in SS2. Other survey projects are in
midstream with some data processed into FWD and some field data still being collected with old
TMOSS codes.

What is the process of migrating current InRoads survey data from the Select Series 2 version
to the Select Series 4 version and what potential challenges or problems may arise from the
migration?

Definitions Used in This Document

DTM- as used in this document designates the legacy terrain model format which normally has
a file extension of DTM. After import the DTM data becomes an OpenRoads terrain model
element.

FWD- the files used in Select Series 2 for storing of survey data. The FWD files will contain all
the edits as performed using SS2 survey software. After import, the FWD data becomes an
OpenRoads Survey DGN file.

OpenRoads - Since the migration in question here amounts to migrating files from traditional
InRoads technology to OpenRoads technology, in the remainder of this document the term
“OpenRoads” is used to designate the Select Series 4 files or technology.

SS2 — This refers to the InRoads V8i Select Series 2 version of the software. In the remainder of
this document the term “SS2” is used to designate the InRoads V8i Select Series 2 files or
technology.

Terrain Model — The OpenRoads format of terrain models which are stored in DGN files.

Example Datasets

The example dataset used in this document is project 20514 - US 50 Orchard Mesa Resurf.

The workflow shown here requires a specialized seed file named “Seed To Migrate SS2
Survey.dgn”. This seed has been added to the standard workspace. The use of this file is
explained in Section |I.

Additional Information

Please refer to the CDOT Workflow IR 183 Using InRoads SS2 and SS4 with MicroStation
SS4document for more information on how to set up a MicroStation DGN file so that it will open
MicroStation by itself, MicroStation and InRoads SS4, or MicroStation and InRoads SS2, as well
as setting up Project Defaults for your project.
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Workflow IR 23 - Migrating Survey from InRoads Select Series 2 to OpenRoads Select Series 4

Workflow Description and Examples

Section I. Import FWD Survey Data (Used for Case 1, Optionl
and Case 2)

In this section of the workflow, the DGN file is set up which will contain the topographic data, by
importing the FWD file generated in InRoads Survey SS2.

This section uses a special seed file which has been constructed to accommodate the migration
of InRoads SS2 survey files into OpenRoads. This seed file is named “Seed to Migrate SS2
Survey.dgn”. Itis pre-populated with unique survey project settings which accommodate the
substitution of new SS4 linking codes for the old SS2 linking codes.

In this example, field book “US50SouthAll01.fwd” is imported.

1. In ProjectWise, navigate to the desired project folder. Typically, this will be the
\ROW_Survey\Drawings\Reference Files folder for the project.

2. Use the seed file Seed to Migrate SS2 Survey.dgn to create a new DGN file which
will contain the processed survey data. Drag and Drop the seed file into the
desired location in ProjectWise. The seed file is located in the following directory:
C:\Workspace\Workspace-CDOT_SS4\Standards\seed

| Y -~
= !ﬁ_ﬁ
@‘\J'I » Computer » Windows (C) » Workspace » Workspace-CDOT_SS4 » Standards » seed 'I 5 ’ PR
Organize v Includeinlibrary v Sharewith v Bum  New folder =~ [ ®
BentleyDownloads A Name 2 Date modifie Type
Chris
Z % 2D-Seed_CDOT.dgn
Config.Msi

/% 3D-Seed_CDOT.dgn

= acad.dwg

& Bndge-2D-Seed_CDOT.dgn
/% Brdge-3D-Seed_CDOT.dgn
/& CDOT Cell Seed.cel

Dell
Documents and Settings
Image
Intel
kworking ~
CDOT Preference Seed.upf
LifeCam Files . -
/& Drawing-Seed_CDOT.dgn
& Linkset-Seed_CDOT.dgnlib
& Mao M |-Seed CDOT.dgn 1:26 AM

Mail
MPS
MSOCache

/B Seed To Migrate SS2 Survey.dgn
/¥ Sheet-Seed_CDOT.dgn
%, Thumbs.db

Perflogs

Program Files
Program Files (x86)

13 ftems
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Workflow IR 23 - Migrating Survey from InRoads Select Series 2 to OpenRoads Select Series 4

3. Rename the file Seed to Migrate SS2 Survey. dgn that was copied into ProjectWise
to JPC#Survey-Topo.dgn. In this example, 20514Survey-Topo.dgn is used.
4. After opening the to JPC#Survey-Topo.dgn file, set the Annotation Scale to 1"=1".

] msm—

1) Title Blocks updated successfully!

5. Assign the appropriate geographic coordinate system. (Menu: Tools >
Geographic > Select Geographic Coordinate System). See CDOT-Setting a
Project Geographic Coordinate System.ddtated in the project:
\ROW_Survey\Drawings\Reference_Files\Control_Diagrams\ folder in ProjectWise
for more information.

This file will now be used for processing the FWD files produced in InRoads Survey
SS2.

6. Open Project Explorer from the Primary Tools toolbox docked at top of screen
or from Menu bar by selecting File > Project Explorer .

@-O-5-8-B-&d-2-R - - ‘JJ@

7. Left click on the Survey tab in Project Explorer and expand the model named
“CDOT Default”

"™ Project Explorer = X

e Links Fle 9 Utiity Model [ Survey 7 Civil Model ¥ Givil Standards
-} [ Survey Data
5[ CDOT Defaut
L[ AET) Field Books
"y Filters
----- Muttimedia Files
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Workflow IR 23 - Migrating Survey from InRoads Select Series 2 to OpenRoads Select Series 4

Note: If the Survey tab is not shown then go to Menu: Settings > Project Explorer and
set the entry for Survey to True, then click OK.

m Project Explorer Settings

Browsers -~
Civil Standards True
Civil Model True
True v
Utility Model True
File True
Links True
Display v
Dialog Properties w
DGN Indexing Properties w
Cance

8. Create a new field book by right-clicking on “Field Books” and selecting New
from the pop-up menu.

1 Project Explorer

B Links Fle 9 Utlity Model [ Suvey 2 Civil Model “8p Civil Standards

=-[A | Survey Data
5[] CDOT Defauit

-

b T Filters
L Muttim Creatlz@errain Model From Field Book Selection Set
" Properties

9. In the Selecting Settings dialog box, select “CDOT Migrate from SS2” then left click
the Accept button.

[ Selecting Settings

]
Accept

Selecting settings to use
CDOT Miarate from 552
g ___
4 CDOT Migrate from 552
| CO@F=Fraject_Ssttinga.a=47TD0OT Settings

Note: This selection is necessary because the seed file used has special survey settings
already embedded which assist in the migration of the SS2 survey data. Thus,
OpenRoads finds two settings, one in the active DGN and one in the workspace.
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Workflow IR 23 - Migrating Survey from InRoads Select Series 2 to OpenRoads Select Series 4

10. After the field book is created, right-click on the new field book and then click

Properties in the pop-up menu. This displays the Element Information dialog
box.

1 Project Explorer

B Links Fle 9§ Uty Model £ Suvey 2 CivilModel ¥ Civil Standards
=-[A | Survey Data
5[] CDOT Defautt
=) Field Books

NI Field Pk 1
i[~I"y Fiters Load *
Muitimed Delete

Export To [

Create Terrain Model...

|f' Propertigs
Sy

11. In the Element Information dialog box, change the name of the field book to
JPC# Survey From FWD. 20514 Survey From FWD is used in this example.

0 Element Information

=x0)

e [ 20514 Survey From FWD

Field Book m -~

Name 20514 Survey From FWD
Control Points

Data Files

Linear Features
Point Features
Setup Points
Observation Points

coocoo

Note : It may be desirable to review the changes in the survey settings in this special
seed file.
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Workflow IR 23 - Migrating Survey from InRoads Select Series 2 to OpenRoads Select Series 4

12. Left click the Civil Standards tab of project explorer.
13. Expand the branch of the tree labeled 20514Survey - Topo > Project Settings >
Survey.

=i Cvil Randarde
_IE 20514Survey-Topo dgn
o] Gl Cells
I'I Desm Stmdards

=] hﬂ Fﬁ-nqac: Setr.nga

P ﬁ’ Comidor Design Stapes
; g Linear Template Design Stages
E-uq‘;? Survey

P COOT Migrate from 552

i m- ol Wiy Fiters
Bt Libranes

14. Right click on CDOT Migrate from SS2 setting and select Properties from the
popup menu. This displays the Element Information dialog box.

-4 Crvil Standarde
] BB 205145urvey-Topo.dgn
i G-l G Cells
5 -l Design Standands
i VI8 Featurs Definitions
|_| m Projact Settngs
P ﬁ’ Conidor Design Stages
' Linear Template Design Stages

III Tmn Fikers Copy
- Uity Fiters Delete

H-u7 Libranes

Renarme
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Workflow IR 23 - Migrating Survey from InRoads Select Series 2 to OpenRoads Select Series 4

15. In the Element Information dialog box, notice that Create Terrain Model for All
Field Books is False.
a. Ifthisis a finished survey (Case 1, Option 1 from above) then leave this
as False.
b. If this is an unfinished survey (Case 2 from above), then change this to
True.

0 Element Informatien = *

5%

Lo CDOT Settings

General

Extended

General Settings
Paints

Linking Codes

Cata File Parsing
Adjustment Defaults

Elements Symbology

> (C||C|(C||€||c||c €| ¢

Terrain Model

Create Terrain Model for All Field Boc

<

Name s

Feature Definition No Feature Definition
Edge Method

Length 0

Note: For a finished SS2 survey (Case 1), the terrain model will not be generated from
the survey data in the files being processed. The reason for this is that the DTM file
generated in SS2 has already been checked, corrected and approved. This approved
DTM will be used for the ground surface.

Colorado Department of Transportation

Page 9



Workflow IR 23 - Migrating Survey from InRoads Select Series 2 to OpenRoads Select Series 4

16. Then, in the Data File Parsing tab, click on the ellipsis = next to Substitution
Strings.

@ Element Information — x

E

ﬁ CDOT Migrate from 552

General ~

Description Application Data

Extendead

General Settings

Linking Codes

Data File Parsing

b4
b4
Paints v
b4
~
I

Data Import ltems 4 Neutral Fle *xnf 0 2
Use Substitute Strings True
ErETreETTr S 0 ST BC NT SBI0 BC NT BNTIDE...|
Description Separator -

Attribute Separator =

Adjustment Defaults -
Elements Symbology 4
Terrain Model v

17. In the list which opens, notice that the old SS2 linking codes are being replaced
with the OpenRoads linking codes.

-': String Substitutions

o X B i “a
Accept | Mew Delete | Paste Special Import Export
Whole\Word | Substitute | With
» False STBCNT SB
False BC NT BNT
False EC NT ENT
True SPC SAP
True EXTARC co
True RND ns
True X ox*
True CLR C5
True ST BC SB
True STX ST
True KX, X

18. Close the Substitution Strings and Element Information dialog boxes.
19. Left click the Survey tab in Project Explorer.
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Workflow IR 23 - Migrating Survey from InRoads Select Series 2 to OpenRoads Select Series 4

20. Then right click on the field book and then click Load > File from the popup
menu. 20514 Survey From FWD is used in this example.

Lo Project Explorer

s Links Fle 9 Utiity Modell [ Survey Civil Model  “§ Civil Standards
E-f [ Survey Data e
-] CDOT Defaut
Blj Field Books
=10

.. Data Files Load » || File...l\

[+~1*, ALL Point Fe

Sl Alllnearf  Delete File Uy Text Import Wizard...

% ALL Cortrol Export To 3 TrimbleLink...

%7 ALL Setups
L[ ALL Observe

[/ Filters ' Properties Features From Current Graphics

-{Z) Muttimedia Files

Create Terrain Model... Leica DEX...

21. Highlight the desired fieldbook file and left click the Open button. For this
example US50SouthAll0l1.fwd is selected.

(3 Select file
Select
Folder
| [ Field_Books v e Bl=EER
CYrs -|p
Document
Mame Folder Created Version
/205145UR‘M’FieIdbook'D1 (1-70).fwd 11/25/2017 11:33:43 AM 2 —
- US3050uthAlIOT fuvd 11/25/2017 11:33:43 AM
/USSﬁSouthControI.fwd 11/25/2017 11:33:43 AM 2
< >
Address: ||:|w:‘\‘I,VHQPWZU1.dot.siate.co.us:|:|wiseproducﬁon\Domments‘l,Training - CDOT_Info\InRoads S52-554 Transitior |
Description: | US50SouthAlll |
File Name: | US505outhAllo1. fwd |
Application: All Applications ~
Open document as read-only

Note: Occasionally, (not in this dataset, however) it will be found that the FWD file

contains points which have already been duplicated during the SS2 processing. The

following image shows an example from a different dataset which exhibits this behavior.
Colorado Department of Transportation
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Workflow IR 23 - Migrating Survey from InRoads Select Series 2 to OpenRoads Select Series 4

What has happened is the original survey processing created a duplicate of point 20050
and named the duplicate 20050_1. This duplicate is not in the same location as the
original point. Now, OpenRoads is processing the data and sees that 20050 is dual
coded and creates point 20050_1 from the dual code. Later, when the SS2 point
20050 _1 is encountered this warning comes up. The best way to handle this is to add a
suffix to the SS2 point as shown below.

Duplicate Point Feat...

o & L
Apply  Apply Al Cancel

Option  Differences

(") Overwrite 20050 1

() Skip

(") Rename

(®) Next Name Prefix I:I
Counter

The data will be processed and drawn into the DGN file

i .
\ﬁﬂfﬂw‘ﬁ;a
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Workflow IR 23 - Migrating Survey from InRoads Select Series 2 to OpenRoads Select Series 4

The steps below illustrate the method for correct some point code errors in the survey
data found in the example data.

22. It will be useful for the remainder of this section to turn off the point annotations.
right click on All Point Features and choose Annotations > Turn Off All
Annotations from the popup menu.

"1 Project Explorer = X
Fle 9§ Utity Model [ Suvey 7 Civil Model I Civil Standards A+

=-fA Survey Data
Z-[fE] CDOT Defaut
2| Field Books

=] [ 20514 Survey from FWD
Data Files
)Y L Poirt Features
— Mew...
| Annotations... 3 | Turn off Name
B Properties Turn off Feature
| Turn off Description
- [e) Muttimedia Files Turn off Elevation

Turn off Custorn Operations
Turn off VBA Annotations

Turn off All [anotations

S|

There will be 3 linking errors found, which appear to be errors which were never
corrected in the original survey processing.

There is an electric line which jumps across the project. This is caused by a missing start
code at point 29951

23. . Adjust the start code as shown below.

g Definition

Colorado Department of Transportation
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Workflow IR 23 - Migrating Survey from InRoads Select Series 2 to OpenRoads Select Series 4

There is a line coded 3110 which is missing a start code at point 29877.

24. Correct this error by adjust the start code as shown above.

There is an error in a gas line near the north end of the project. This appears to be an
aborted start at a new gas line.

25. To correct the error, change the code on southernmost point (point 29341) to
“Start”. In this case, it would be best to review this gas line with the original
surveyor to confirm the change.

| A&cPC
4 | MonTanPC
L_',fucSlr'_:Ie
& |ArcTobre
¢ | ManTanPT
., ArcPT
ArcToggle
i + =
{§ MNone fcioseshape

! * 'Cloze
f . -

1
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Workflow IR 23 - Migrating Survey from InRoads Select Series 2 to OpenRoads Select Series 4

Once the corrections have been made, the FWD conversion to OpenRoads is complete.

26. If this is a completed survey (Case 1, Option 1) and the FWD file processed
above constitutes the entire survey then proceed to Section II.

If this is an unfinished survey (Case 2 from above):

27. Return to step 19 and process any remaining field data files (SDR, CSV, etc.)
which have been collected in the field with the old TMOSS codes. The
processing of these files will continue in an iterative fashion until all survey data
has been processed and edited as described above.

28. Deliver the DGN file, including the terrain model produced in the survey
processing to Design.

Best Practices — Process Survey

1 Keep in mind that the process as shown in this document uses the FWD file for
topographic data only. If the FWD file is from a finished SS2 survey, then the
QA/QC process will be a little more streamlined. However, it does not mean that
the elevations can be completely ignored. Since the survey lines may be used for
point controls by the road designer, be sure to make a review of the elevations as
well as the 2D data.

Potential Errors and Problems — Process FWD

1 Waitch for duplicate points.

N Review the imported data to insure there are no uncorrected linking problems.
The FWD file should reflect the final state of the finished survey in SS2.
However, there could have been mistakes or unfinished work as seen above
which still needs to be corrected.

Colorado Department of Transportation
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Workflow IR 23 - Migrating Survey from InRoads Select Series 2 to OpenRoads Select Series 4

Section Il. Import DTMs to Terrain Models (Case 1, Option 1
Only)

If the survey data processing for the project has been completed, then proceeding with this
section will produce an OpenRoads terrain model DGN file of the existing ground and other
existing surfaces rather than deliver DTM files to design. The OpenRoads terrain models will be
separate files from the DGN file which contains the processed survey data.

Workflow — Import DTM

Since the DTM file produced in the original survey has been checked and approved then that
terrain model will be imported to OpenRoads, rather than using the terrain model which can be
automatically generated by OpenRoads Survey

The importing of DTM files is very simple. It requires only selecting the DTM file and choose an
OpenRoads feature definition which is assigned to the imported surface.

In the following exercise, the primary existing ground DTM will be imported to an OpenRoads
terrain model. The import process needs to be repeated for all DTM files which represent exiting
surfaces, such as bridge decks. When importing terrain models, it is usually best practice to
have only one OpenRoads terrain model per DGN file. If the project contains multiple small
terrain models, then it could be acceptable to place several into a single DGN file.

1. In ProjectWise, navigate to the desired project folder. Typically, this will be the
\ROW_Survey\Drawings\Reference Files folder for the project.

Use the seed file 3D-Seed_CDOT.dgn dgn to create a new DGN file which will contain
the processed survey data.

2. Drag and Drop the seed file into the desired location in ProjectWise. The seed
file is located in the following directory: C:\Workspace\Workspace-
CDOT_SS4\Standards\seed

3. Reame the file to JPC#EXxistingTerrainModel.dgn. In this example,
20514ExistingTerrainModel.dgn is used.

4. Assign the appropriate geographic coordinate system. (Menu: Tools >
Geographic > Select Geographic Coordinate System). See CDOT-Setting a
Project Geographic Coordinate System.ptiicated in the project:
\ROW_Survey\Drawings\Reference_Files\Control_Diagrams\ folder in ProjectWise
for more information.

Colorado Department of Transportation
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Workflow IR 23 - Migrating Survey from InRoads Select Series 2 to OpenRoads Select Series 4

1. From the Tasks menu, expand the Civil Tools task.

Tasks - 0%
| & Tasks - |
X 1R A X

& Colorado DOTTools &a = == &

i

=B

Y civil Workflows dl
L

(M InRoads Commands

% Civil Toals |

4 Subsurface Utilities |
“! Drawing w
4 Drawing Composition L
Ay Terrain Model L

2. Under the Civil Tools task, expand the Terrain Model tasks.

<. Honzontal Geometry v
BB vertical Geometry v |
A Terrain Model v I
1ﬁ Corridor Modeling v
& Model Interoperability -

3. In the Terrain Model tasks, left click Create from File button. This displays the
Select Files to Import dialog box.

# Terrain Model HEE A

2 = Ay B A AR A

R R K-8 INEN
P Y. R
AREaxs

fﬂ Corndor Modeling w

4. In the Select Files To Import dialog box, navigate to the desired location.
Typically, this will be the \ROW_Survey\inRoads\DTM folder for the project.

Colorado Department of Transportation
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Workflow IR 23 - Migrating Survey from InRoads Select Series 2 to OpenRoads Select Series 4

5. Highlight the desired DTM file then left click OK. This displays the Import Terrain
Model(s) dialog box. In this example, 20514SurvSurface01(l -70).dtm is sekcted.

[ Select Files To Import b4
Sedact
Documents
Folder | [ DTM - B EEA
#|n «|p
Mame
Bl 205145URVSurface(]-70).dtm
B 205145URVS urfaceD2(- 70).ctm
& B V55050uth.dtm
< >
Application All Applications ks
Extension All documents ~
Add Remave
Selected Doouments
Mame File Marmne Description

===

6. In the Import Terrain Model(s) dialog box, set the Feature Definition to Terrain
Perimeter > Existing Border.

|‘]_|»_ Import Terrain Model(s)

( il x E Options

B, 205145 URVSufacs01(-70) LT -

Append to existing Terrain Model

Terrain Model to append to

Filter ~
Source File Units ‘Unk.nown ~ |

Feature Definition ~
Feature Definition [No Feature Definfion =]
Import Options [ @ No Feature Definition

- CDOT_Civil_S54xin
ol Termain Contours
- Temsin Fow Amows
Source [ = Temain Peimeter
" N ExistincyBorder
H @& Propos{.Border
Source Units i Temain Triangles

Target [

Geographical Coordina

Source Description

Target Description

Target Units

Import

PW_WORKDIR:d21280684205145URVSurfaceD1(l-70).dtm
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Workflow IR 23 - Migrating Survey from InRoads Select Series 2 to OpenRoads Select Series 4

Note: Feature definition of Existing Border is used here because the boundary is very
quick to draw on-screen. Contours and triangles can be slow for very large or very dense
terrain models. Using Existing Border is a good idea for DTM files. The display can be
changed once the terrain element has been imported.

7. Set the Import Option to Impor t Terrain Only . This imports only the terrain model
and not the Features. The features are incorporated in the terrain model.

Note: Because there are difficulties with features imported from the DTM, such as; the
custom line styles are tilted perpendicularly on the slope of the terrain which looks odd
and the point features display only as dots, use the JPC#Survey-Topo.dgn to view
features.

8. Left click the Import button.

= = o)
Import Terrain Modelis) =L “
~ - Dptons
E= X S
20545 URVSuoce 1070 Toryein Modeln .
Append 1o existing Terrain Mode
erraim Mode! to append to
Filter -~
Source File Units Linknown IBe
Feature Definition -~
Feature Definition Existing Border | >
Import Options Import Terain Only | w
Geographical Coordinate Systems v
PW_WORKDIR:d2128068\20514SURVSurface01 (I-70).dtm
&

9. Once processing is complete, close the Import Terrain Model(s) dialog box.
10. Fit View to see the imported terrain model.

= View1 - Top, CDOT Defaut | =8 R =5
Eraw-AQRHEHS O VWYFHD ST ERE

Colorado Department of Transportation
Page 19



Workflow IR 23 - Migrating Survey from InRoads Select Series 2 to OpenRoads Select Series 4

Best Practices — Import DTM

T
T

Use 3D seed files when starting a new DGN that contains a terrain model.

Generally, store only one terrain model per DGN file, unless they are small. This is for
better performance.

Assign a geographic coordinate system to the DGN file before import the DTM file. This
allows transforming the DTM on the fly during the import process, if needed.

When importing the DTM file, use a feature definition which displays the boundary only
to start. Thus, there will be minimal delay in draw time. DTM files which contain very
large numbers of triangles or dense contours will take a while to draw if the feature
definition shows these by default. After the DTM is imported and the boundary looks OK,
then the feature definition can be changed.

There is usually not a need to import both the terrain model and the features. (step 7
above) Ordinary features, such as triangles and break lines are automatically created as
components of the terrain model element.

Potential Errors and Problems — Import DTM

1 Picking the wrong feature definition for the terrain model, but this is easily changed in
the properties of the terrain model after import.

1 Choosing a feature definition at import which displays triangles or contours by default
could be slow to draw on screen if the imported DTM is very large.
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